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Background 

Mapping data provided by the Surveillance, Epidemiology, and End Results (SEER) 

Program (https://seer.cancer.gov/) has several types of challenges. One 

methodological challenge is to create more truthful maps. Similar to many health 

datasets, each SEER estimate include its standard error, indicating its reliability. 

Typically, mapping of these health statistics and many statistical estimates using 

choropleth maps ignores the reliability of these estimates, treating the estimates as if 

they are perfectly accurate without error. The resultant maps likely put observations 

(areal units) with estimates not statistically different into different map classes. 

Similarly, observations with estimates that are statistically different may be put into the 

same class (Sun and Wong, 2010). Consequentially, resultant maps may be misleading, 

showing spatial patterns that may not exist, or concealing patterns buried in the data.  

SEER*CMapper, also known as the Class Separability Classification Tool (CSCT), is an 

implementation of the class separability classification method (CSCM) for choropleth 

map to address this mapping issue (Sun, Wong and Kronenfeld, 2015). Different from a 

typical GIS or choropleth mapping package, SEER*CMapper can generate a choropleth 

map with a confidence level (CL) associated with each class break value. This CL level 

is approximately the minimum probability that any pair of values above and below the 

class break value are statistically different. In other word, this CL indicates how 

effective this class break in separating estimates that are statistically different into 

different classes. If this CL is low, estimates above and below that specific class breaks 

are not highly separable, and vice versa. In other words, that class break is not a 

desirable class break. However, CL is entirely determined by the quality of the 

estimates. If estimates are highly unreliable (with large standard errors), then the CL 

cannot be relatively high. Please refer to Sun et al. (2015) for the detail of the CSCM. 

SEER*CMapper computes a confidence level for each potential class break value in the 

background process. Logically, class break values with relatively high probabilities 

(CLs) should be selected. If only a small number of classes are needed, the CL values for 

the small number of class breaks may be relatively high (again, the quality of estimates 

https://seer.cancer.gov/
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determines the CL values). When more classes are needed, the CL values of subsequent 

classes become lower. Therefore, in SEER*CMapper, users will use the minimum 

acceptable CL level indicated by a slider bar to determine the number of classes (and 

subsequent class break values). Unfortunately, choosing class break values with the 

highest probabilities often results in highly uneven map classes, very much due to the 

general empirical distributions of data. Therefore, users may want to adjust the class 

breaks to obtain more balanced classes. SEER*CMapper allow users to manually and 

heuristically adjust the class break values to derive more desirable classification (Sun et 

al., 2017). The CL value provided for each class break value will aid users to evaluate 

and manipulate class breaks. 

SEER*CMapper can be used to map SEER estimates and many other datasets for 

estimates with error or data quality information (e.g., ACS), as long as the data include 

the additional column indicating either the standard error (SE) or the margin of error 

(MOE) of the estimates. However, SEER*CMapper has the specific functions to handle 

estimates with standard errors downloaded from SEER*Stat 

(https://seer.cancer.gov/seerstat/). Data downloaded from SEER*Stat can be ingested 

directly into SEER*CMapper to create a choropleth map. Users can manipulate map 

classification with the CL indicated for each class break. The resultant map can be 

exported into a graphic file to be used for reporting.  

To summarize, SEER*CMapper: 

- Is a stand-alone mapping program that does not require GIS software or 

additional GIS data. 

- Can directly ingest data downloaded from SEER*Stat.  

- Can create maps using the CSCM, modifying class breaks determined by CSCM, 

and using other popular classification methods (natural breaks, quantiles, and 

equal intervals). 

- Provides a confidence level for each class break, regardless how the class break is 

determined.  

- Produces maps at the state or county level, depending on the input SEER data. 

- Can perform all the functions above, using shapefiles as the input.   

 

Requirements of Using SEER*CMapper 

There are several system and user requirements to use SEER*CMapper: 

1) This is a stand-alone tool developed in Java. Java is supported in Windows, OS X 

and Linux. Therefore, users should have computers using these operating 

systems, and ensure that the Java Virtual Machine (JVM) or Java Runtime 

https://seer.cancer.gov/seerstat/


3 
 

Environment (JRE) is installed (it is installed on many machine. Go to 

www.java.com to find out if you have JVM/JRE installed. If not, you can also 

install Java through that site). Also, users need to ensure that Java is not disabled 

on your web browser. 

2) Displaying the resultant choropleth map and the associated interactive graphics 

user interface (GUI) elements require relatively large graphics memory for large 

datasets. Therefore, it is advisable to use a computer-laptop that has a separate 

graphics card with 4MB or larger memory. Graphics memory below this level 

may still work for less complicated maps (state-level maps), but the display may 

be slow or even incomplete. 

3) Users intended to create choropleth maps of SEER data should be a (registered) 

user of SEER*Stat. It means that the user should have a SEER*Stat account and 

already has access to the SEER database (and have the SEER*Stat program 

already installed). 

4) Users should have a basic operational knowledge to access and download data 

from the SEER database.  If you are new to SEER*Stat or do not know which 

dataset(s) you may want to download from SEER, please visit the SEER website 

for tutorials. (https://seer.cancer.gov/seerstat/ and 

https://seer.cancer.gov/seerstat/tutorials/) 

 

Download SEER data from SEER*Stat 

The SEER*CMapper tool expects the data downloaded from SEER meet certain format 

requirements. Therefore, it is important to follow the procedure below to download and 

format data from the SEER website accordingly. After the data are downloaded, users 

can launched the SEER*CMapper to map the downloaded data. Note that the mapping 

program uses only rates data with standard error (SE) at the county and state levels. 

This document and procedure are prepared under several assumptions: 

 Data to be mapped are only at the state or county (county-equivalents: parishes 

for Louisiana and boroughs in Alaska) level. Other administrative and statistical 

units (e.g., incorporated cities, metropolitan, SEER registry areas) are not 

supported. 

 County-level boundary data are based on the county definition adopted in the 

2010 Decennial Census.  

 

1) After launching SEER*Stat on the desktop, under the “File” manual, choose “New” 

and “Rate Session.” (You may be asked to login at this point – please login to 

proceed). 

http://www.java.com/
https://seer.cancer.gov/seerstat/
https://seer.cancer.gov/seerstat/tutorials/
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2) Click the “Data” tab: 

- Select a dataset 

- You can choose either an “Incidence” or “Mortality” dataset. 

 

3) Then click the “Statistic” tab: 

- Inside the “Statistic” box on the left, choose either “Rates (Crude)” or “Rate (Age-

Adjusted).” 

- If “Rate (Age-Adjusted)” is chosen, be sure the relevant parameters are provided. 

- Check the box for “Show Standard Errors and Confidence Intervals” 

- Checking the box for “Use Tiwari et al., 2006 modification for CIs” will not affect 

the mapping program. 

 

4) Then click the “Table” tab: 

- Under “Available Variables” window (lower panel), expand the tree with “… 

State, Cnty” or “… Registry, County”. Note that “State” and “County” are often 

listed with other variables such as “Race, Sex, Year Dth/Dx”. 

- Select one of the geographical levels (do not include more than one level): 

o Select “State” for tabulation at state level. 

o Select “State-county” for tabulation at county level. (Do not select just 

“county”) 

o Select “Registry/county” for tabulation at the county level if “State-

county” is not available. 

- Click “Row” on the right to add the selected geography to the Row variable. 

- You may add other non-geographical variables to the columns to be mapped.  

- Note that this program is designed to map rates. Therefore, it is not 

recommended to add many non-rate variables or a large number of variables not 

intended to be mapped. 

 

5) Click “Execute” (the lightning icon) to generate the table. 

 

6) After the table is displayed on screen, click the “Matrix” menu tab, choose “Export” 

and “Results as Text File.”  A form similar to the one below (Figure 1) will appear. 
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Figure 1: Export window in SEER*Stat. 

 

- Provide a filename for the Data File (e.g., output1.txt). 

 

- Use the SAME name for the Dictionary File (e.g., output1.dic). Make sure that 

both files are saved in the same folder. 

 

- Then choose the following export parameters: 

o Output Variables as – select “Labels Enclosed in Quotes” 

o Line Delimiter – “DOS/Windows” 

o Missing Character – “NA” 

o Field Delimiter – “Comma” 

 

- Check the following boxes: 

o Enclosed Fields Containing Delimiter in Quotes 
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o Remove All Thousands Separators (Commas) 

o Remove Flags (Footnote), Prefix and Suffix Characters 

o Preserve Matrix Columns and Rename Fields 

 

- Then click “OK” 

* Because “Preserve Matrix Columns and Rename Fields” is checked, field names will 

be replaced (truncated) in the shapefiles created by SEER*CMapper. This is necessary 

because many field names from SEER*Stat are too long to be accommodated by 

shapefiles. However, when the .dic file is used to create choropleth map in 

SEER*CMapper, the original field names are shown in the Variable Picker. * 

Download and Launch SEER*CMapper 

SEER*CMapper can be downloaded from http://geospatial.gmu.edu/seer-cmapper. 

This user manual can also be obtained from the above website. Click the link to 

download the compressed (zip) file to the folder where the user would like to store and 

access the mapping tool (such as “C:\…\SEERCMapper” where “SEERCMapper” is the 

folder.)   

* Note that this folder SHOULD NOT be the folder where you store your typical 

download files or installation programs, as this downloaded file is not an installation 

program. * 

After the file is downloaded, unzip (or “extract”) the content of the file. It should have 

18 items: 17 files and a folder (mapping_lib). These files may be grouped into three sets: 

a set of shapfiles for the U.S. states, another set for the U.S. counties, and the file 

“mapping.jar” is the executable Java file of the SEER*CMapper that accesses procedures 

in the mapping_lib folder. Double-clicking the “mapping.jar” file will launch the 

mapping program. Two default windows will appear. They are the “Variable Picker” 

and “Bar Chart Controller.” (Figure 2)  

* Note that at the bottom of the Controller is a 5-color bar corresponding to different 

percentages and a movable cursor (a black vertical marker) to the right. The percent 

refers to the confidence level of class separability. * 

  

http://geospatial.gmu.edu/seer-cmapper
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Figure 2: The interface of SEER*CMapper 

 

 

Creating choropleth maps using SEER*CMapper 

When launching SEER*CMapper, users should have downloaded rate data from 

SEER*Stat according to the format prescribed above in this manual. Data downloaded 

from SEER*Stat should include two files with .dic and .txt as the extensions. To bring 

these data files into SEER*CMapper, go to the “File” menu item and choose the only 

option: “Open Shp/Dic File.” Then an “Open” file window will appear. For “Files of 

Type,” make sure that “Dic files” is selected. Then navigate to the folder where the 

SEER .dic file is stored and select the .dic file to open. Then the data in the .dic and 

corresponding .txt files will be loaded into the “Variable Picker” window. The column 

labels in the SEER data will be displayed identically under the two columns of the 

Variable Picker window. (Figure 3) 

* Note that depending on the speed of your computer, slower computer and larger 

datasets (i.e., SEER datasets with many columns) may take longer time. * 
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Figure 3. Column labels in SEER data are ingested into the Variable Picker window. 

 

 

In the Variable Picker window, please choose the column label for the estimate (left 

column of the Picker window) and choose the column label for the error variable (right 

column of the Picker window). After choosing these two columns, the bottom of the 

picker window should specify the type of error variable. SEER*CMapper accepts 90% 

MOE, 95% MOE, and standard error (SE) as the error variable. In SEER, the error 

variable is standard error. Therefore, the specification of the error variable should be 

switched to “The error variable is standard error (SE).” Then click the “Send selection” 

button.  

In Figure 3, it shows that “00_04_yrs_Non_white_Rate” is the chosen estimate on the 

left column, and “00_04_yrs_Non_white_SE” is the chosen error variable on the right 

column (these are variables derived from SEER*Stat for “Mortality - All COD, 

Aggregated With State, Total U.S. for Hispanics (1990-2000) <18 Age Groups> “ – these 

files are available as “Sample Datasets” in the tool website). After clicking “Send 

selection”, a pop-up message “Completed loading data” will appear when the data are 

ingested into the system. 

Then, under the “Classification Window” menu, choose “chart”. A “Bar Chart 

Container” window will appear. It starts as a blank window with values on the y-axis 

and a bar of different colors on the x-axis. There are several ways to “activate” the bar 

chart window. An easy way is to drag the cursor (black vertical marker) on the 5-color 

bar in “Bar Chart Controller” window to the left slightly. Then in the bar chart window, 

vertical bars indicating the estimates and the error bars at the tips of the vertical bars 
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indicating the standard error will appear (Figure 4). The cursor on the 5-color bar refers 

to the minimum confidence level or separability that a user is willing to accept for all 

class breaks.  

As shown in Figure 4, by dragging the cursor to 70%, the minimum separability 

accepted by a user, one dark blue line and two light blue lines are inserted onto the bar 

chart. These lines are the resultant class breaks using the CSCM. The class break 

indicated by the dark blue line has a separability level of 80% or higher while the two 

breaks indicated by the light blue lines have separability levels between 60% and 80%. 

Users can tell that these line colors correspond to the colors on horizontal color bar on 

the bar chart. In other words, colors on the horizontal bar indicate the separability level 

of each potential class break. Users can move the cursor along the color bar in the 

controller to experiment different levels of separability and the resultant classes. The 

higher the acceptable separability level (CL), fewer classes are determined. By lower the 

acceptable separability level, more class breaks can be identified.    

Figure 4. Bar chart with inserted class breaks by dragging the cursor to the desirable 

separability level. 

 

 

To visualize the resultant classes on a map, under the “Classification Window” menu, 

check “Map” and a choropleth map using the class breaks determined via the bar chart 

will be displayed in the Map window (Figure 5). Note that this map has a special legend 
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design with a probability - a confidence level (CL) attached to each class break on the 

left side of the legend. In this specific example, estimates between the first class (162-

217) and estimates in all other classes are different at least 73.2% of the time. Similarly, 

estimates between the first two classes and the last two classes are different at least 

77.8% of the time. These two class breaks are indicated by the two light blue lines in the 

bar plot. Given the data here, the highest separable classes are between the last class 

and all other classes (80.2%). This class break is indicated by the dark blue line in the 

bar plot. Because the cursor was dragged down to about 70%, only class break values 

with a separability level (CL) of 70% or higher will be used. If more classes are 

preferred, the additional classes will have separability levels lower than 70%.  

Figure 5. Choropleth map with a class separability legend generated by the 

SEER*CMapper. 

 

* Note that although the bar plot will show more than nine classes of class break, the 

map display will support up to nine classes only, as studies indicate that most people 

cannot handle more than nine classes in a choropleth map. When more than nine classes 

are determined in the bar plot, a warning message will appear in the Bar Chart 

Controller window and the map will not be shown. To force a map to display, the 

number of classes has to be reduced to nine or less. To do so, check the radio button 

next to “Entering number of classes” under “Determining classes by.” Then enter a 

value of 9 or less for the number of classes. Make sure that the classification method is 

“Class Separability” before hitting the “Apply” button. Then a map with the highest 

separability levels (CLs) will be produced. * 
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The map window, through the menu icons, supports several standard functions: zoom-

in and out, pan, maximum extent, identify, save, and save (legend only). The “Save” 

tool can save the map and legend as one graphics file (in .png format), and the “Save 

(legend only)” tool save the legend only, not the map.  

 

Adjusting Class Break Values  

Class breaks determined through the CSCM process are the most separable, given the 

minimum separability (CL) accepted by the user. In other words, these class breaks are 

the most reliable in assigning estimates that are statistically different into different 

classes. However, depending on the purposes of the mapping exercise, these classes 

may not be highly desirable according to other map classification criteria. For instance, 

due to the distribution and error levels of data, classes determined via CSCM are 

usually not very balanced. One or two classes will have a large number of observations 

and a few classes have very few observations. Therefore, adjusting the class breaks may 

be necessary. 

In SEER*CMapper, there are several ways to adjust class breaks. Assuming that the class 

breaks determined through the CSCM procedure are not desirable, just like the example 

in Figure 5 that the two break values are too close (the two light blue lines in the bar 

plot), SEER*CMapper allows users to delete, add, and move class breaks through the bar 

plot. In the “Bar Chart Controller” window, three buttons allow users to perform such 

manipulations. For instance, it may be desirable to move one of the light blue lines 

toward the middle section of the plot as there is no class break for a large number of 

observations. Then, users can click the “move” button (the button will turn red), and 

move the mouse cursor to select the light blue line on the right. (Figure 6) When the 

class break line is selected, it will turn to black. At this point, when the cursor moves 

across the plot, a line following the cursor will appear intermittently. When the mouse 

clicks again, the selected class break line will be moved to the new position. The 

question is where should the new class break be? 
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Figure 6. Moving a class break from a high separability level (light blue) to a moderate 

level (yellow) in the middle section of the bar plot. 

 

 

Ideally, the new class break should have a relatively high separability level. But all 

potential breaks with higher separability levels have been identified already. Any other 

value chosen as the class break will have a lower separability level. Still, if giving up a 

highly separable class break is desirable, the alternate class break should still have a 

separability level as high as possible. To search and select the next most desirable break 

value, users may refer to the horizontal color bar (x-axis) in the bar plot where the 

colors correspond to different levels of CL in the Bar Controller window. With no light 

blue in the middle section, the next best choice is yellow with a moderate separability 

level. (Figure 6) Note that when the class break is moved, the map display is also 

refresh to reflect the change. The new class break has only 41.7% of CL. The other class 

break manipulation methods (add/new and delete) operate in a similar manner. First, 

select the button in the Controller window and then apply the method onto the bar plot.  

 

Evaluating the Reliability of Map Classes 

SEER*CMapper not only can be used to determine class breaks using the CSCM, it can 

also be used to evaluate the reliability of map classes determined by other popular 

classification methods. SEER*CMapper includes several popular map classification 

methods to create choropleth maps. These methods are natural breaks, equal interval 

and quantile. To use any of these classification methods, the button for “Entering 
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number of classes” under “Determining classes by” should be checked (the default is 

“Using slider”). Then select a classification method and enter the desirable number of 

classes (again, it is limited to nine). Clicking the “Apply” button will refresh the 

displays of the bar plot and map.  

In Figure 7, the natural breaks classification method was chosen with four classes. Both 

the bar plot and the map displays reflect the new classification result. In this specific 

example, the two most separable classes determined by the natural breaks method are 

the same as those determined by CSCM, but the remaining class break using the natural 

breaks classification method has a separability level of only 23.2%. Thus, SEER*CMapper 

can be used to evaluate the reliability of classes determined by popular map 

classification methods. 

Figure 7. Resultant map using the natural break classification. 

 

 

Heuristic Adjusting Class Breaks 

The number of classes, separability levels of class breaks, and classification methods are 

interrelated. Using a specific classification method, the separability levels of class breaks 

cannot be adjusted freely, but are predetermined, given the number of classes. 

Therefore, SEER*CMapper also includes a tool for users to review these relationships in 

a graphical manner and the graph also serves as an interface to select a specific map 

classification scheme.  

Under the Classification Window menu is an item for “Star Plot.” Clicking this menu 

item will display a star plot showing the relationship between the number of classes, 
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averaged separability level, and within-class variability. Within-class variability refers 

to the variation of estimates within a class. It is essentially the standard deviations of 

estimates within each class summing across all classes. The details of these criteria can 

be found in Sun et al. (2017). Figure 8 shows the star plot of choosing the quantile 

classification method of the same data set used above. 

* Note that the star plot will appear only when the classification method other than the 

separability method is selected under the “Choose a classification method” window. *  

Figure 8. Star plot with three axes corresponding to three criteria to evaluate a map 

classification. 

 

 

As the star plot is generated when quantile is the chosen classification method, the plot 

shows the averaged separability and within-class variability levels when different 

numbers of classes are used. Their relationships are shown by lines connecting the three 

axes, forming polygons. Each polygon is a combination of class number, averaged 

separability and within-class variability levels. Class numbers and separability levels 

are inversed related as discussed above. Class numbers and within-class variability are 

usually correlated. The polygons (lines) in the star plot are clickable so that users can 

select a classification scheme based on these three criteria, and the map display will be 

updated by the chosen scheme. In other words, users can interactively select 

classification scheme through the star plot and visualize the resultant classification from 

the map window. 
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